
Introduction to PascGalois JE (Java Edition)

So what is PascGalois JE? The PascGalois project was started in the late 1990’s as a new and innovative
way to visualize concepts in an introductory abstract algebra course, primarily group theory. Although this
is still its main function the project has branched out into areas of number theory, discreet mathematics,
dynamical systems and combinatorics. In 2004, the software was totally rewritten in Java so that it could
run on any operating system, not just Windows. Furthermore, we revamped the user interface to make the
program easier to use and built a rule-based calculation engine so that the program will support more types
of group structures. Since the first release of PascGalois JE we have revised the user interface several times
and have added many new features, such as three-dimensional viewing of two-dimensional automata, ad-
vanced element counting, generalized update rule input, and probability density graphing of two-dimensional
automata.

As with any program, when you add more and more options the user interface gets more complicated
and the ease of use decreases. We have tried to make this program as easy to use a possible by using a
tabbing system. Each tab represents a set to options so the user does not have to navigate through all of
the program options at once and in many cases can ignore some of the options. Although we still use the
program for our first course in abstract algebra you may feel that the PascGalois JE program has become
more of an undergraduate research tool instead of a teaching tool. This is why we have also constructed a
series of easier to use applets. The applets restrict the options that the user has and as the series progresses
the applets introduce new options at each stage. By the end of the series the user has used most of the
facilities on the PascGalois JE program.

So which should you use? The sequence of written labs we have constructed use the PascGalois JE
program and the sequence of web-based labs (which you can find on our web site www.pascgalois.org) embed
the applets in the lab itself. So if you want to use the full set of features from the start you should use this
sequence of labs with the PascGalois JE program. On the other hand, if you are finding the PascGalois JE
program too cumbersome to use you should use our web-based sequence of labs. There are a few things
you should note about the applets. First, each of the applets have corresponding applications that can be
downloaded from our web site. Second, applets can not access the user’s hard drive nor can they access the
computer clipboard. This means that if you use the applets you will not be able copy images to a word
processor nor will you be able to save the current settings of the program. So if you are writing up a lab
report and using the PascGalois JE program you will be able to transfer images and information over to
your word processor. On the other hand, if you are using the web-based labs with the applets the only way
to transfer the image to your word processor is to open the the applet in full screen mode and do a screen
capture (Alt+PrintScreen in Windows) and then paste this into your word processor.

So what does it do? It graphs one and two-dimensional cellular automata over finite group structures.
Here is an easy example of a one-dimensional cellular automaton. Consider Pascal’s triangle and its con-
struction using the “adding the two entries above” rule. That is, put 1’s down the diagonals and for each
entry inside the triangle add the two entries above it. You will get the following,

1
1 1

1 2 1
1 3 3 1

1 4 6 4 1
1 5 10 10 5 1

1 6 15 20 15 6 1
1 7 21 35 35 21 7 1

1 8 28 56 70 56 28 8 1
1 9 36 84 126 126 84 36 9 1

1 10 45 120 210 252 210 120 45 10 1

1



Another way to think about this is to consider the first row (the single 1) as a starting point (or seed)
with 0’s going out infinitely in both directions. That is,

. . . 0 0 0 0 1 0 0 0 0 . . .

In the language of cellular automata we call this time-step 0. The next row, or time-step 1, is taken from
the first row by adding each two consecutive entries together, obtaining

. . . 0 0 0 1 1 0 0 0 0 . . .

we do it again for time-step 2,
. . . 0 0 0 1 2 1 0 0 0 . . .

time-step 3,
. . . 0 0 0 1 3 3 1 0 0 . . .

time-step 4,
. . . 0 0 0 1 4 6 4 1 0 . . .

and so on.

Now we will go a little further, we will take each of the entries mod a particular number n. For example,
let n = 3, generate Pascal’s triangle and then mod each entry by 3.

1
1 1

1 2 1
1 3 3 1

1 4 6 4 1
1 5 10 10 5 1
...

...
...

...
...

...

mod3=⇒

1
1 1

1 2 1
1 0 0 1

1 1 0 1 1
1 2 1 1 2 1
...

...
...

...
...

...

You should note that this is exactly the same as if were were to generate Pascal’s triangle using addition
mod 3. That is, start with your seed of

. . . 0 0 0 0 1 0 0 0 0 . . .

Now do the addition rule but after each addition take the result mod 3. For time-steps 1 and 2 it makes no
difference we still get

. . . 0 0 0 1 1 0 0 0 0 . . .

and
. . . 0 0 0 1 2 1 0 0 0 . . .

Now for time-step 3 we have,
. . . 0 0 0 1 0 0 1 0 0 . . .

and time-step 4,
. . . 0 0 0 1 1 0 1 1 0 . . .

and so on. The point is that we are still constructing Pascal’s triangle we are just using the group operation
of Z3 instead of addition (which is the group operation of Z).

Yes, we are going yet another step further. Numbers are nice but in this form it is a bit difficult to see
patterns. So what we will do now is color each entry of the triangle a color that corresponds to the group
element. If we color 0 red, 1 black and 2 green and graph about 100 rows or time-steps we get the following
image.
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Clearly we have some structure here. What you will see in this sequence of labs is that these triangles
can hold far more information about the structure of the group.

The PascGalois Project and the PascGalois JE program derive their names from Pascal and Galois since
the first visualizations were using Pascal’s triangle with group theoretic operations (the Galois portion of the
name). The PascGalois JE program is capable of producing automata using many other group structures as
well as other seeds and update rules, it is not restricted to Pascal’s triangle. For this lab we will stick to Zn

and Pascal’s triangle.

Before going into the software let’s get a feel for what it is doing. Your first assignment is to create some
of these triangles by hand.

Exercises:

1. By hand generate the first 10 rows of Pascal’s triangle.

2. By hand generate the first 10 rows of Pascal’s triangle, mod 2.

3. By hand generate the first 10 rows of Pascal’s triangle, mod 3.

4. By hand generate the first 10 rows of Pascal’s triangle, mod 4.

5. By hand generate the first 10 rows of Pascal’s triangle, mod 5.

6. By hand generate the first 10 rows of Pascal’s triangle, mod 6.

7. For each of the triangles mod 2, 3, 4, 5 and 6, above use different colors to color in the triangle. Note
that you should only color the triangles that point upward.
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An Introduction to the Software

To get you started, try doing the following. Keep in mind that the techniques introduced here can help
guide your investigations in the labs.

Some basics about triangle generation

1. We are going to start out with Pascal’s triangle modulo 2.

(a) Open PascGalois JE, you should see something like the window below.

PascGalois JE uses a tab system to navigate through all of the options in the program. Some
of the tabs may be a little overwhelming since they contain many options but we have designed
the program so that the user does not need to do too much with them at the start and can ease
into the program options over time. Under most circumstances there are very few things you
will need to change and, in fact, there are some tabs you will not change unless you are doing
research in this area. Each of the internal windows have four tabs: Group, 1-D Automaton, 2-D
Automaton and Calculator. The Group tab is where you select the group structure you wish to
work with. The group type is in the top drop-down selection box. Currently it is set to Zn (in
other words Zn). The program has the capability of working with most of the groups you will
see in an introductory abstract algebra class. The box directly below the group type selector is a
text box that allows you to input the n. Since we are interested in Z2 we will keep this set to 2.

(b) Click on the 1-D Automaton tab. There are 5 sub-tabs here but you will mainly be working with
just 3 of them.
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The first tab contains just a few basic options. The Automata option is for selecting between a
finite and an infinite automaton. Most of the time you will be interested in infinite automata,
so we will leave this option as is. The second option is the alignment. The pin alignment will
create equilateral triangles and the column alignment will create a right triangle. We will keep
the pin setting. The next option is to draw a circle or square for the elements, keep this as circle.
The number of rows is, of course, the number of rows that program will graph past the “seed”.
We will not change the seed this time and there is only one row in the default seed so the actual
number of rows graphed will be the number in this box plus one. Set the number of rows to 10,
that is, we will graph 11 rows. The final option is the default element. We will not get into what
this is at this point, just remember that the default element is usually the group identity. To
automatically load in the group identity click on the Use Group Identity button. If you do you
will see that the entry does not change, since 0 is the identity of Z2.

(c) We will not change the seed or the update rule this time, so click on the Image tab. You should
see something like the image below. The middle area is a split pane so you can click and drag the
middle vertical divider if you so wish.

6



The program does not automatically redraw the image when a change is made since the graphing
process can take a long time for some automata. Hence to regraph the image after one or several
changes have been made click on the Refresh/Apply tool in the upper right, just above the Color
Scheme. Once you do you should see the following image.

• First note that there are 11 rows to this triangle. This is because the program generated 10
rows after the seed. The seed is the starting configuration for the triangle. In our example
the seed was just a 1, as can be seen in the top position of the triangle.

• Also note that the color correspondence between the numbers and colors is given in the box
to the right. Although it is not the case here, if you have a large set of colors it may be a bit
confusing which color is in which position. If you hold the mouse over the triangle a tool-tip
will appear with the position and the entry. For example if (6, 5): 1 is in the tool-tip then
your mouse is over the position in row 6, column 5 and the element in that location is a 1.
This information will also appear in the status bar of the window.

• Compare the PascGalois image with your mod 2 pascal’s triangle.

2. From the menu select File � New, or select the New toolbar option, at this point a new window will
open. Set up the group and options generate the first 11 rows of Pascal’s triangle modulo 3. That is,
change the n value from 2 to 3 and the number of rows to 10. Compare the PascGalois image with
your mod 3 Pascal’s triangle.

3. Open two more new windows. One feature that makes it easy to compare and contrast these images
is window tiling. Select Window � Tile from the menu, or select the Tile tool from the toolbar. This
should “split” your program into four windows. You may have noticed that the triangles you previously
graphed might not fit quite right in their windows. They may be too large or too small. To update an
image you need to click the Refresh/Apply button directly over the color scheme window.

4. In the two new windows graph Pascal’s triangle mod 3 with 81 and 243 rows respectively. This time
take into account that the first row is the seed row. That is use 80 and 242 as the number of rows. In
the window that you had 10 rows (really 11) of Pascal’s triangle mod 3 change it to graph 27 rows,
again taking into account that the first row is the seed row. Notice any similarities between the three
mod 3 graphs?
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Some basics about colorings

Often our choice of coloring affects the type and/or amount of structure we observe in Pascal’s and other
related triangles. We will see that altering the colors often reveals hidden structure in the images.

When you generate a triangle the program will use the default color settings and color each element a
unique color (up to 60 elements and then it rotates the color scheme). The program allows you to change
the color of any element as well as group sets of elements together with the same color. We will look at a few
examples below. There is also a feature where you can drag and drop colors from one window to another.
Furthermore, you can save and load color schemes that you create.

1. Close the windows that are currently in the program. Select Window � Close All from the menu or
click the Close All tool from the toolbar. You will get a warning message for each window that has
not been saved, simply click Yes for all of them.

2. Open a new window.

3. Generate Pascal’s triangle modulo six in this window, keep the number of rows at the default 100.

4. Just to see how to change the color of an individual color do the following. Double-click the element
3 either on the image or the element list. At this point the color chooser dialog box will appear, as
below.

Select a purple color and click OK. You will notice that the color has changed in the color corre-
spondence box. Now click the Refresh/Apply toolbar button. Notice what happened to the triangle
image.

5. To reset the colors to the default scheme select the Colors � Reset to Default Color Scheme in the
menu.

6. Now we will highlight colors. Select both 3 and 5 from the color correspondence. To select multiple
items simply hold down the Control key and click all the items of interest. Now select Colors �
Highlight Elements from the menu. You will notice that the elements that were selected are now
colored red and the other elements are black. Let’s change these colors before refreshing the image.
Double-click either the 3 or the 5 and select the color yellow. Now double-click any of the black colors
and select a gray color. Notice that all of the colors in the respective groups changed when you made
a single change. This is because the elements are now linked together. The 3 and 5 are considered a
set and the 0, 1, 2 and 4 are a set. Refresh the image.

7. To ungroup the colors select Colors � Reset to Default Color Scheme from the menu and refresh the
image.

8. We will use another type of color grouping, subset grouping. In the color correspondence window select
the numbers 0 and 3. Select Colors � Group Elements from the menu. Note that 0 and 3 are now the
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same color. Now select 1 and 4 and then select the Colors toolbar button followed by Group Elements.
Finally select 2 and 5 followed by the Colors toolbar button and then Group Elements. Refresh the
graph.

9. Reset the colors to the default scheme and refresh the image.

10. You can also use the PascGalois triangle itself to select colors. Put the mouse over a section of red
(the element 0) and double click. The color selector will appear for the element 0. Select a different
color and click OK. Note that the new color is in the color correspondence box. Refresh the image to
see the new triangle.

11. Another way to change an element’s color is to right-click on the element either in the color corre-
spondence box or on the image and a small popup menu will appear with four options, Set Element
Color, Set Element Color to Transparent, Copy Color and Paste Color. If you select the transparent
option the color box will simply be a rectangle with an X through it. Refresh the image to see the
change. The Set Element Color will bring up the color chooser dialog box as before. Copy and paste
will of course copy and paste the color to and from the system clipboard. You can also change the
background color by selecting Colors � Set Background Color.

12. A few other things to note about color changes. There are several other grouping options under the
Colors menu, we will use these in later labs. Also, there are options to undo and redo color scheme
changes. The program will keep up to 20 changes for each color scheme. There are also facilities to
add, remove and rename color schemes. If you do add color schemes you can select the different color
schemes using the drop-down selector over the color scheme window. Finally, the first two options
under the File menu are options to save and load color schemes.

Some basics about zooming

1. If you don’t have Pascal’s triangle modulo six on the screen please regenerate it, keep the number of
rows at the default 100.

2. Select Zoom � Zoom In from the menu. Notice that the mouse pointer has changed when you are
in the triangle window. Click somewhere inside the triangle. Click several more times to see what
happens.

3. Select Zoom � Zoom Out from the menu. Notice that the mouse pointer has changed again. Click
somewhere inside the triangle. Click several more times to see what happens.

4. Select Zoom � Reset Zoom to Full View from the menu. Notice that the mouse pointer has not changed
but the triangle has zoomed out to its fullest.

5. Select Zoom � Turn Off Zoom from the menu. Notice that the mouse pointer has changed back to its
default.

6. The default zoom is 2X. This can be changed by selecting Zoom � Zoom Factor from the menu followed
by the desired zoom factor.

7. Select Zoom � Zoom Box from the menu.

8. Click and drag over a portion of the triangle. Note that the area will be shaded. Release the mouse
button and the program will zoom in on the selected portion. The program may need to alter the
bounds of the selection but you will get at least what you selected.

9. If you are in the process of zooming with the Zoom Box feature and notice that your area is not what
you want you can cancel the zoom by pressing the right mouse button before releasing the left button.
Give this a try.

10. Reset the zoom to full view and turn the zooming off.
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11. There are also facilities to undo and redo zooms. The program will keep a maximum of 50 zooms in
memory.

Some basics about file and clipboard transfer of images and information

The PascGalois JE program allows you to save and retrieve the triangle information as well as save both
the triangle images and the color correspondence images to either bitmap, jpeg or png image formats. I
would suggest using either jpeg or png since these formats are more universally accepted by other programs.
Furthermore, you can transfer images and data to the clipboard so they can be quickly transferred into most
word processors. You will notice that there is a File menu for the program and a File menu in each of the
internal windows. The File menu in the main menu is for saving and loading the group and automaton
setup information. It will save the information for the currently selected internal window. All other file
and clipboard options are contained in the internal window. We will not go over all of the facilities in the
program but we will discuss some of the more useful ones. You should open a word processor like Microsoft
Word, WordPerfect or Open Office so you can see how the program copies and pastes information.

1. Saving and loading automaton information.

(a) In a new window create an automaton for Z7 using 49 rows.

(b) Select File � Save from the menu or click on the save tool in the toolbar. A file save dialog box
will appear. Save the file as test001.pgd. Note that the program will put the extension (pgd) on
automatically.

(c) Select File � Open from the main menu. A file open dialog box will appear. Open the test001.pgd
file. Note that the program will put it in a new window. Notice that the group is Z7 and the
number of rows in the options is what you input.

(d) Go to the Image tab and click the refresh button to see the image.

2. Saving or coping the image.

(a) Simply select File � Save Image. . . or File � Copy Image from the internal menu.

(b) If you are saving the image a dialog box will appear asking for a filename and file type. The file
type is taken from the extension. So if you type in img.jpg for the name the program will save it
as a JPEG file. If you do not include an extension the program will take the extension from the
file type selector at the bottom of the dialog box with a JPEG default.

(c) If you selected the copy option, switch over to your word processor and paste the image into your
document.

3. Saving or coping the color correspondence.

(a) Select File � Save Color Correspondence. . . . This option has a submenu with two items on it,
Save as Single Image and Save as Multiple Images. If you select Save as Single Image the program
will place all of the colors and elements on a single image, 25 per column. If you select Save as
Multiple Images the program will place save a sequence of graphic files with 25 elements per file
and those elements will be in a single row. To copy the color correspondence to the clipboard
select File � Copy Color Correspondence to Image. This will copy the colors and elements to the
clipboard as a single image.

(b) If you are saving the image a dialog box will appear asking for a filename and file type. The file
type is taken from the extension. So if you type in img.jpg for the name the program will save
it as a JPEG file. If you do not include an extension the program will take the extension from
the file type selector at the bottom of the dialog box with a JPEG default. Also, if you save as
multiple images the filenames will be altered to img_0001.jpg, img_0002.jpg,. . . .

(c) If you selected the copy option, switch over to your word processor and paste the image into your
document.
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4. Saving or coping selected data.

(a) Saving and coping selected data as well as counts (which we are not going into in this lab) require
that you select a region of the image first. There are several options for selecting regions in the
program and you can find a discussion of these in the help screen system. We will simply select
a couple rows. Graph the first 100 rows using Z6.

(b) Zoom in on the top of the triangle so that you can easily see the first 5 or 6 rows.

(c) Select Counts & Data � Select Rows. At this point a select rows dialog box will appear. Put 0
for the starting row and 5 for the ending row. Once you click OK you will see that the program
has “highlighted” the first 6 rows.

(d) Select File � Copy Selected Data � as Text. This has copied the element data in the first 6 rows
to the clipboard using the tab character between the entries.

(e) Open or switch to your word processor and paste in the data. Since we only copied the first 6
rows the data should fit well on the page. On the other hand, there may be times when it would
be better for you to put this data into a table. Most word processors have a facility for converting
text to a table. In either Word or Open Office, select the lines of data and then select Table �
Convert � Text to Table. A dialog box will appear for you to select options, just make sure that
the tab is the separator character.

(f) A couple notes about data selection. First, you can select any region, not just rows, and the
program will copy it as a formatted block. You can also save this data to a file by selecting the
saving option. There is also an option to save or copy the data as LATEX code. LATEX is a free
mathematics typesetter which is a standard in mathematical writing.

There are many other features of the program that will help you visualize many concepts in mathematics.
As you experience the labs, we will direct you to some but feel free to explore the program’s capabilities on
your own. There is a help system available that you can read through that can help your exploration. Have
fun!
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